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Introduction 

This getting started guide describes the Atmel® ATWINC3400 Wi-Fi® Network 

Controller to build state-of-the-art Internet of Things (IoT) applications. The guide 

explains hardware information and how to install Atmel Studio (IDE), compile 

examples, and download ATWINC3400 firmware. 

The following topics will be covered: 

 How to get Atmel Studio (IDE) and install it 

 Update new ASF package 

 Target board information 

 How to get time client example project 

 How to get log message 

 How to download firmware and certificate 

Prerequisites 

 Hardware Prerequisites 

– Atmel SAM D21 Xplained Pro Evaluation Kit 

– Atmel ATWINC3400-XPRO extension board  

– Atmel IO1 extension board 

– Micro-USB cable (Micro-A / Micro-B) 

 Software Prerequisites 

– Atmel Studio 7.0 

– Time client example project source code 
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1 Icon Key Identifiers 

 Delivers contextual information about a specific topic. 

 Highlights useful tips and techniques. 

 Highlights objectives to be completed. 

 Highlights the expected result of an assignment step. 

 Indicates important information. 

 Highlights actions to be executed out of the target. 
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2 Getting Started with Atmel Studio 

2.1 Download and Install Atmel Studio 7.0 

Atmel Studio is the integrated development platform (IDP) for developing and debugging Atmel ARM® Cortex®-

M and Atmel AVR® microcontroller (MCU) based applications. The Atmel Studio 7.0 IDP gives you a seamless 

and easy-to-use environment to write, build, and debug your applications written in C/C++ or assembly code. 

Atmel Studio 7.0 is now available, adding advanced debugging features such as Data and Interrupt Trace, 

improved RTOS integration, and better ability to debug code that has been optimized. 

With the introduction of Atmel Gallery and Atmel Spaces, Atmel Studio 7.0 further simplifies embedded MCU 

designs to reduce development time and cost. Atmel Gallery is an online apps store for development tools and 

embedded software. Atmel Spaces is a cloud-based collaborative development workspace allowing you to host 

software and hardware projects targeting Atmel MCUs. 

Download and install Atmel Studio 7.0 from http://www.atmel.com/tools/ATMELSTUDIO.aspx. 

 

 

 

You can find the installed directory: C:\Program Files(x86)\Atmel\Atmel Studio 7.0. 

2.2 Download and Install the Latest ASF 

Atmel Studio 7.0 is free of charge and is integrated with the Atmel Software Framework (ASF) — a large library 

of free source code with 1,600 ARM and AVR project examples. ASF strengthens the IDP by providing, in the 

same environment, access to ready-to-use code that minimizes much of the low-level design required for 

projects. Use the IDP for our wide variety of AVR and ARM Cortex-M processor-based MCUs, including our 

broadened portfolio of Atmel SAM3 ARM Cortex-M3 and M4 Flash devices. 

If the ASF version in your Atmel Studio is not the latest one you will be notified when Atmel Studio starts. The 

following procedure demonstrates how to update the ASF to the latest version. You can install other extensions 

in the list as well. 

http://www.atmel.com/tools/ATMELSTUDIO.aspx
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2.2.1 How to Update Atmel Studio to the Latest Version 

1. Run Atmel Studio 7.0. 

 

2. You can see the start page of Atmel Studio 7.0. 

 

 

Update ASF to the latest version. 

Menu → Tools → Extension Manager 

 
 

Available Downloads → Updates → Atmel Software Framework 
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Select an extension and proceed with download and installation: 

 

 Restart Atmel Studio to take effect of the newly installed extension. 

3. Restart Atmel Studio. 

4. Open the Tools and Document via File → New → Example Project (Ctrl + Shift + E). 

   



 

Getting Started Guide for ATWINC3400 W-Fi using SAM D21 Xplained Pro [USER GUIDE] 
Atmel-42640A-Getting-Started-Guide-for-ATWINC3400WiFi-using-SAMD21-Xplained-Pro_UserGuide_02/2016 

7
 

7 

3 Getting Started with Atmel Hardware 

This chapter introduces Atmel Evaluation Kits for testing IoT applications. The SAM D21 and the ATWINC3400 

are essential but the IO1 and the OLED1 extension boards are optional. 

3.1 Atmel SMART SAMD21-XPRO Evaluation Kit 

The Atmel SAM D21 Xplained Pro evaluation kit is ideal for evaluating and prototyping with the Atmel SAM 

D21 ARM Cortex-M0+ based microcontrollers. Extension boards to the SAM D21 Xplained Pro can be 

purchased individually. 

 

  

 SAMD21J18A microcontroller 

 One mechanical reset button 

 One mechanical user pushbutton (wake-up, bootloader entry, or general purpose) 

 One yellow user LED 

 32.768kHz crystal 

 USB interface, device and reduced host mode 

 8Mb Serial Flash 

 Three Xplained Pro extension headers 

 Embedded Debugger 

– Auto-ID for board identification in Atmel Studio 7.0 

– One yellow status LED 
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– One green board power LED 

– Symbolic debug of complex data types including scope information 

– Programming and debugging 

– Data Gateway Interface: SPI, I²C, four GPIOs 

– Virtual COM port (CDC) 

 USB powered 

 Supported with application examples in Atmel Software Framework 

More detailed information about SAM D21: http://www.atmel.com/tools/atsamd21-xpro.aspx 

3.2 Atmel SmartConnect ATWINC3400-XPRO Wi-Fi Extension Board 

Atmel SmartConnect ATWINC3400 is an IEEE® 802.11 b/g/n IOT network controller SoC. It is the ideal add-on 

to existing MCU solutions bringing Wi-Fi and Network capabilities through SPI-to-Wi-Fi interface. The 

ATWINC3400 connects to any Atmel AVR or SMART MCU with minimal resource requirements. The 

ATWINC3400 most advanced mode is a single stream 1x1 802.11n mode providing up to 72Mbps PHY 

throughput. ATWINC3400 features fully integrated Power Amplifier, LNA, Switch, and Power Management. 

The ATWINC3400 provides internal Flash memory as well as multiple peripheral interfaces including UART, 

SPI, and I2C. The only external clock source needed for the ATWINC3400 is a high-speed crystal or oscillator 

with a wide variety of reference clock frequencies supported (between 12 – 32MHz). The ATWINC3400 is 

available in a QFN package. 

 

 

 

 IEEE 802.11 b/g/n (1x1) for up to 72Mbps 

 BLE Provisioning 

 Integrated PA and T/R Switch 

 Superior sensitivity and range via advanced PHY signal processing 

 Wi-Fi Direct®, station mode, and Soft-AP support 

 Supports IEEE 802.11 WEP, WPA2 Security Enterprise 

 On-chip memory management engine to reduce host load 

 8Mb internal Flash memory with OTA firmware upgrade 

 SPI as host interfaces 

 TCP/IP protocol stack (client/server) sockets applications 

 Network protocols (DHCP/DNS) 

http://www.atmel.com/tools/atsamd21-xpro.aspx
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 Secure TLS stack 

 WSC (wireless simple configuration WPS) 

 On-Chip Network Stack to offload MCU 

– Integrated Network IP stack to minimize host MCU requirements 

– Network features: TCP, UDP, DHCP, ARP, HTTP, SSL, and DNS 

More detailed information about ATWINC3400: http://www.atmel.com/devices/ATWINC3400.aspx 

3.3 Atmel IO1-XPRO Sensor Extension Board 

Atmel IO1 Xplained Pro extension board is a generic extension board for the Xplained Pro platform. It connects 

to any Xplained Pro standard extension header on any Xplained Pro MCU board. The extension board utilizes 

all functions on the standard Xplained Pro extension header to further enhance the feature set of Xplained Pro 

MCU boards. 

 

 microSD card connector 

– 2GB microSD card included 

– Accessed with SPI interface 

 PWM 

– LED control 

– PWM → Low pass filter → ADC 

 ADC 

– PWM → Low pass filter → ADC 

– Light sensor 

 UART 

– Loopback interface via pin header 

 TWI 

– AT30TSE758 Temperature sensor with EEPROM 

 Xplained Pro hardware identification system 

More detailed information about AT IO1: 

http://www.atmel.com/images/atmel-42078-io1-xplained-pro_user-guide.pdf 

http://www.atmel.com/devices/ATWINC3400.aspx
http://www.atmel.com/images/atmel-42078-io1-xplained-pro_user-guide.pdf
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3.4 Atmel OLED1-XPRO Display Extension Board 

Atmel OLED1 Xplained Pro is an extension board to the Atmel Xplained Pro evaluation platform. The board 

enables the user to experiment with user interface applications with buttons, LEDs, and a display. 

 

 UG-2832HSWEG04 monochrome OLED display 

– 128 x 32 pixels 

– Controlled by 4-wire SPI interface, up to 100MHz 

 Three LEDs 

 Three mechanical push buttons 

 Xplained Pro hardware identification system 

More detailed information about Atmel OLED1 Xplained Pro:  

http://www.atmel.com/images/atmel-42077-oled1-xplained-pro_user-guide.pdf 
  

http://www.atmel.com/images/atmel-42077-oled1-xplained-pro_user-guide.pdf
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4 How to Debug ATWINC3400 Wi-Fi Firmware 

 

ATWINC3400 Xplained Pro board provides UART interface for debugging. You can connect the ATWINC3400 

XPRO board to your PC using a USB-to-Serial device and a debug USB connector to get firmware debug 

information. 

Open the ATWINC3400 DEBUG USB serial COM port, with the following settings: 

 460800 baud 

 8-bit data 

 No parity 

 One stop bit 

 DTR/DSR flow control 

Open a serial terminal tool to see the result. (ATWINC3400 Wi-Fi Firmware Debug information.) 

  



 

Getting Started Guide for ATWINC3400 W-Fi using SAM D21 Xplained Pro [USER GUIDE] 
Atmel-42640A-Getting-Started-Guide-for-ATWINC3400WiFi-using-SAMD21-Xplained-Pro_UserGuide_02/2016 
1

2

 

12 

5 How to Download New ATWINC3400 Firmware 

5.1 Download Firmware 

This section demonstrates the use of the ATWINC3400 with the SAM D21 Xplained Pro board to upgrade 

firmware of the ATWINC3400 Wi-Fi module. This is a basic operation to download firmware. It uses the 

following hardware: 

 The SAM D21 Xplained Pro 

 The ATWINC3400-XPRO on EXT1 header 

Connect the SAM D21 (DEBUG USB PORT) to the USB port on your PC. 

 Do not connect SAM D21 VIRTUAL COM PORT via terminal program. 

 

STEP1: Build the Serial Bridge application on the SAM D21 Board. 

1. Open “samd21_xplained_pro_serial_bridge” project located under src\Tools\ from the release package. 

This project supports serial bridge function on SAM D21. 

2. Build the program. 

STEP2: Firmware update to the ATWINC3400 Board. 

1. Launch the following batch file from the release package. 

\src\download_all_sb_samd21_explained_pro.bat 

 

 SUCCESS firmware download. The following information will be displayed on the com-
mand window. 
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SAMD21 flashing script: please connect edbg and power up the board. 
Firmware check OK 
Chiperase completed successfully  
Firmware check OK 
Programming completed successfully. 
Mode UART 
Downloading Image... 
******************************************** 
*  >Programmer for WINC3400 SPI Flash<     * 
*      Owner:  Atmel Corporation           * 
******************************************** 
. . . 
 
******************************************** 
*   >TX Gain Builder for WINCxxxx <        * 
*      Owner:  Atmel Corporation           * 
******************************************** 
. . . 
 
************************************************** 
* > WINC3400 Root Certificate Flash Downloader < * 
************************************************** 
. . . 
 
Done 
 
>>This task finished after  2.92 sec 
OK 
    ####################################################################### 
    ##                                                                   ## 
    ##                 ########     ###     ######   ######              ## 
    ##                 ##     ##   ## ##   ##    ## ##    ##             ## 
    ##                 ##     ##  ##   ##  ##       ##                   ## 
    ##                 ########  ##     ##  ######   ######              ## 
    ##                 ##        #########       ##       ##             ## 
    ##                 ##        ##     ## ##    ## ##    ##             ## 
    ##                 ##        ##     ##  ######   ######              ## 
    ##                                                                   ## 
    ####################################################################### 
Downloading ends successfully 

 FAILED firmware download. The following information will be displayed on the command 
window. 



 

Getting Started Guide for ATWINC3400 W-Fi using SAM D21 Xplained Pro [USER GUIDE] 
Atmel-42640A-Getting-Started-Guide-for-ATWINC3400WiFi-using-SAMD21-Xplained-Pro_UserGuide_02/2016 
1

4

 

14 

SAMD21 flashing script: please connect edbg and power up the board. 

Firmware check OK 

Chiperase completed successfully 

Firmware check OK 

Programming completed successfully. 

Mode UART 

Can not find image_builder path... 

Downloading Image... 

******************************************** 

*  >Programmer for WINC3400 SPI Flash<     * 

*      Owner:  Atmel Corporation           * 

******************************************** 

2B0 Path ../../../firmware/m2m_aio_2b0.bin 

3A0 Path ../../../firmware/m2m_aio_3a0.bin 

3400 Path ../../../firmware/m2m_aio_3400.bin 

>>Init Programmer 

Detecting ports... 

EDBG Virtual COM Port (COM37) 

(APP)(ERR)[nm_bus_port_detect][567]Failed to find any COM ports 

0 of ports found 

(ERR)Failed To intilize programmer 

Fail    
####################################################################### 

##                                                                   ## 

##                    ########    ###     ####  ##                   ## 

##                    ##         ## ##     ##   ##                   ## 

##                    ##        ##   ##    ##   ##                   ## 

##                    ######   ##     ##   ##   ##                   ## 

##                    ##       #########   ##   ##                   ## 

##                    ##       ##     ##   ##   ##                   ## 

##                    ##       ##     ##  ####  ########             ## 

##                                                                   ## 

####################################################################### 

If you see a failed message, you must check if your device is assembled correctly. 

 You must check the terminal program. Do not connect SAM D21 VIRTUAL COM PORT 
via terminal program. 

 

Power cycle the board and retry firmware download again. 
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6 Getting Started with ATWINC3400 IoT Examples 

This chapter introduces ATWINC3400 IoT examples and describes how to run an example on the SAM D21 

board. 

6.1 Organization of ATWINC3400 IoT Examples 

All these examples are included in the ASF package and there are various IoT examples using Wi-Fi module. 

6.1.1 Basic Examples 

These examples describe basic Wi-Fi operation in ‘how-to’ manner: 

 How to read chip ID (to identify ATWINC3400 H/W revision) 

 How to set debug message level 

 How to get MAC address of the Wi-Fi module 

 How to start Wi-Fi in specific operation mode, such as: 

– STA Mode (Station Mode), and AP mode (Access Point mode) 

 How to switch mode among STA, and AP modes during the runtime 

 How to scan APs nearby 

 How to set deep sleep mode 

 How to connect to secure Wi-Fi with using WEP/WPA/WPA2 security 

 How to connect to enterprise security network 

 How to connect to security WPS 

 How to get RF signal status by reading RSSI value 

 How to set AP provision 

 How to set HTTP provision 

6.1.2 Protocol Examples 

After basic code examples, the user may be interested in how to send and receive network packets. Here are 

protocol examples that can be extended for IoT application. 

 UDP protocol example 

 TCP protocol example 

 NTP Time client – retrieve network time for IoT application 

 MQTT protocol client example 

 Send email – send an email from SMTP server 

 Location client – get the current location of the network provider using HTTP 

6.1.3 Advanced Examples 

These examples demonstrate more complex functions like: 

 Growl client – demonstrates using RESTful API over SSL (essential for IoT application) 

 MQTT Chat client – demonstrate how to send and receive IoT information using MQTT protocol 

 Time client – get the current time information of the network provider 

 Wi-Fi serial - useful for chatting or controlling a remote device 

 OTA Firmware Upgrade – ATWINC3400 Firmware upgrade via OTA server 

 SSL connection - Set up an SSL connection 
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6.2 Connect the Board 

Connect the ATWINC3400 Wi-Fi module to the SAM D21 as shown in the figure below. 

The ATWINC3400 Wi-Fi module comes with a Wi-Fi software API. The purpose of this API is to provide an 

abstraction of the binary protocol used between the host processor and the ATWINC3400 Wi-Fi module while 

keeping an easy and reliable solution to add wireless capabilities to any user application. This software is 

based on the Atmel Software Framework (ASF) and is configured to use an ATWINC3400 Wi-Fi module on 

EXT1 by default. Note that switching to another extension port (EXT2 or EXT3) is possible by modifying a 

configuration file. 

 

 

 Connecting several ATWINC3400 Wi-Fi modules is possible but not supported by the 
provided Wi-Fi Software API. 
For this getting start guide the ATWINC3400 Wi-Fi module will remain connected on 
EXT1. 

Connect the DEBUG USB port on the SAM D21 to your PC using a Micro-USB cable. The SAM D21 will be 

visible in the Windows® Device Manager with its COM port. 

 

Atmel Studio may detect your device automatically and show a proper page. 

DEBUG USB 
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6.3 How to Get Time Client Example Project 

This example demonstrates the use of the ATWINC3400 with the SAM D21 Xplained Pro board to receive time 

information from a time server. It uses the following hardware: 

 The SAM D21 Xplained Pro 

 The ATWINC3400 on EXT1 header 

 The IO1 on EXT2 header 

 A wireless access point 

 A mobile device (for provisioning) 

 

     Time Server  
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1. Open the Time client example via File → New → Example Project (Ctrl + Shift + E). 

 

Input “Time Client” in the search window then you can find an example named like “WINC3400 Time 

Client Example – SAM D21 Xplained Pro”. 
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2. Press the OK button then Atmel Studio will bring over the project source code of the example. 

 

3. Open the “main.h” file and edit the MAIN_WLAN_SSID, MAIN_WLAN_AUTH and MAIN_WLAN_PSK to 

reflect your own AP settings. 

6.4 How to Build and Execute 

This guide demonstrates how to build an example and execute it on the SAM D21 Xplained Pro. 

1. Build the solution (F7) and ensure you get no errors. 

 

2. Connect the ATWINC3400 Wi-Fi extension and the IO1 extension to the SAM D21 Xplained Pro as 

displayed below: 

 

3. Connect the SAM D21 Xplained Pro board to your PC using DEBUG USB connector. 

4. Program the application by clicking on the Start Debugging and Break icon. 
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5. You will be asked to select your debug tool: 

 

6. Select EDBG and SWD (Serial Wire Debug) as Interface and increase the SWD clock frequency to 

12MHz. 

 

7. Click again on the Start Debugging and Break icon: 

 

8. The application will be programmed in the SAM D21 embedded flash and breaks at main function. Click 

on continue to execute the application: 

 

 You may be asked to upgrade your EDBG firmware. If so, click on Upgrade button: 

 

 Upgrade operation may take a few minutes, wait for the operation to complete. 

 The example is now programmed and running. 
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Open the SAM D21 EDBG DEBUG USB serial COM port, with the following settings: 

 115200 bauds 

 8-bit data 

 No parity 

 One stop bit 

 DTR/DSR flow control 

Open a serial terminal tool to see the result. You can use your preferred serial terminal, such as PuTTY, 

TeraTerm, etc. You can also use terminal window plug-in in Atmel studio. You can install it through below 

menu. (Menu → Tools → Extension Manager.) 

Connect to the device. 

 

 The following information will be displayed on the terminal window. 

-- WINC3400 time client example -- 

-- SAMD21_XPLAINED_PRO -- 

-- Compiled: XXX  XX XXXX XX:XX:XX -- 

(APP)(INFO)Chip ID 3400d0 

(APP)(INFO)Firmware ver   : X.X.X 

wifi_cb: M2M_WIFI_RESP_CON_STATE_CHANGED: CONNECTED 

wifi_cb: M2M_WIFI_REQ_DHCP_CONF: IP is XXX.XXX.XXX.XXX 

(APP)(INFO)1 Socket 7 session ID = 1 

resolve_cb: DomainName pool.ntp.org. 

socket_cb: The GMT time is 11:34:50 
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7 Conclusion 

This document explained essential parts of the evaluation kit and an example of use of the Atmel 

ATWINC3400 Wi-Fi module. 

The following topics have been covered: 

 How to get Atmel Studio (IDE) and install it 

 Update new ASF package 

 Target board information 

 How to get time client example project 

 How to update firmware and getting log message 

You have seen how to use the ATWINC3400 Wi-Fi module and manage module software up-to-date. It is an 

essential part of utilizing the other ATWINC3400 resources. 
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8 Revision History 

Doc Rev. Date Comments 

42640A 02/2016 Initial document release.  
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Мы молодая и активно развивающаяся компания в области  поставок 

электронных компонентов. Мы поставляем  электронные  компоненты  

отечественного и импортного производства напрямую от производителей и с 

крупнейших складов мира. 

Благодаря сотрудничеству с мировыми поставщиками мы осуществляем 

комплексные и плановые поставки   широчайшего   спектра электронных 

компонентов. 

Собственная  эффективная  логистика и склад в обеспечивает надежную 

поставку продукции в точно указанные сроки по всей России. 

Мы осуществляем  техническую поддержку нашим клиентам и 

предпродажную проверку качества продукции. На  все поставляемые продукты 

мы предоставляем  гарантию . 

Осуществляем поставки продукции под контролем ВП МО РФ на 

предприятия военно-промышленного комплекса  России , а также работаем в 

рамках 275 ФЗ с открытием отдельных счетов в уполномоченном банке. Система 

менеджмента качества компании соответствует требованиям ГОСТ ISO 9001.  

Минимальные сроки поставки, гибкие цены, неограниченный 

ассортимент  и индивидуальный подход к клиентам являются основой для 

выстраивания долгосрочного и эффективного сотрудничества с предприятиями 

радиоэлектронной промышленности, предприятиями  ВПК и научно-

исследовательскими  институтами России. 

С нами вы становитесь  еще успешнее! 

 

 

 

 

 

Наши контакты: 

Телефон: +7 812 627 14 35 

Электронная почта: sales@st-electron.ru 

Адрес: 198099, Санкт-Петербург,  

Промышленная ул, дом № 19, литера Н,  

помещение 100-Н Офис 331 

mailto:sales@st-electron.ru

